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1 Introduction 

 

V-Archive is software to archive telephone call recordings. V-Archive can 

receive data from a number of Vidicode call recorders like the V-Tap VoIP, 

V-Tap Analog, V-Tap ISDN, V-Mic and Call Recorder VoIP. V-Archive can 

also record calls from a softphone on your PC. V-Archive stores all the 

recorded data, together with the date, time and call number information 

(meta data), and makes playable audio files from it.  

 

Every gigabyte of free disk space allows you to record up to 180 hours of 

conversation on your hard disk, when recording from a VoIP telephone. 

 

V-Archive stores recordings in a versatile database, called the archive. The 

archive is displayed on your computer screen as a list of recordings. In that 

list, the recorded meta data, like date and time, is shown. In the archive, 
all this data is stored together with the actual recording. 

Pre-defined queries for time intervals are available. For example, it is 

possible to search on telephone numbers. Custom queries can be made 

and saved. The database has its own Windows style Recycle-bin. 

Recordings are stored as playable wave files in subdirectories of the 

archive directory (year\month\day\hour). Optionally, the archive is stored 

encrypted. 

 

V-Archive can also import data from, among others, Call Recorder Pico 

(hardware), Oygo (call recording software for softphones and headsets) 

and the V-App (call recording app for Android smartphones). You can 
store all your recordings safely and centrally. 

 

V-Archive can also export (upload) recordings to the Call Recorder Apresa. 
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2 Installation 

 

2.1 Hardware installation 

 
Complete the installation of your Vidicode hardware before you install 

V-Archive. When the hardware is installed, plugged in and powered, the 

V-Archive will recognize it during software installation. This will turn off 

the ads that are otherwise shown by the V-Archive. 

 

2.2 Software installation 

 

Download ‘V-ArchiveInstall.exe’ from www.vidicode.com or use the CD. 

Place the CD in your computer. If the software installation does not start 

automatically, then locate the file ‘V-ArchiveInstall.exe’ (former 

‘CRVoIPInstall.exe’) on the CD and start it by double-clicking. Follow the 

instructions on the screen: 

 

 Select your preferred language for the installation. 

 Confirm the location where the application is installed. 

 Specify a location for the database files. 

 Select whether you want a desktop icon for V-Archive. 

 

 

Note1:  

The V-Archive installer will only recognize V-Tap or CR-VoIP units if these 

recorders are connected to a USB port on the PC running the V-Archive 

installer. Do this if you want the software to turn off the ads. 

 

Note2:  

A separate installation of the WinPcap driver may be needed and is 

started automatically, depending on the absence of this low-level 

network interface driver.  
 

 

When the V-Archive application starts for the first time you will see an 

empty database: 

 

http://www.vidicode.com/
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Several things are important to configure, such as: 

 

i. The language of the user interface. 

ii. The recording licenses. 

 

All options are further explained in the next chapters. 
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3 Configuring V-Archive 

 

3.1 Introduction 

After installing V-Archive, run it as administrator. Then you will be able 
to change all settings. 

Below follows a short description of some possible connected Vidicode 

recorders. For full instructions, see the manuals of these recorders. 

 

3.2 V-Tap Analog 

The V-Tap is a stand-alone device with an SD-card. It is able to record 

telephone calls while your PC is turned off. 

 

Viewing, playing and archiving of 

the calls is done with the V-Archive 

software (or optionally with the 

Apresa, a multi-channel and 

versatile call recording solution). 

 

Go to the Options menu and select 

Setup. Click the Recording tab. Tick 

the box Accept connections from    

V-Tap. Fill in the port number. 

 

 
 

Enter the same port number in the web interface of your V-Tap (see 

next page). The default Tunnel port is 2016. 

 

NOTE: 

The installer software of V-Archive automatically tries to configure the 

firewall on the PC for TCP port 2016. For external firewall software that 

may not succeed and therefore must be configured manually to allow 
traffic on TCP port 2016. 

https://www.vidicode.com/service-and-support/manuals/
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The web interface of the V-Tap Analog is shown below for all the 

Tunnel settings, needed to upload to V-Archive: 
  

 
 

The Tunnel Server Address is the IP address of the PC running V-Archive. 

Leave the Tunnel Source Port and both Tunnel Timeout’s as default. 

At first, don’t use Tunnel Data Encryption and leave the encryption 

password box empty, because this will make it easier to test if V-Archive 

is able to receive data from the V-Tap. 
NOTE1: 

The status line, below in the window of V-Archive, is showing all 

connected V-Taps, together with their MAC addresses. 

NOTE2: 

V-Archive does not need ‘VoIP channel’ licenses to receive from a V-Tap. 

 

3.3 V-Tap VoIP 

See V-Tap Analog for information about the V-Tap in general. 

 

 

You may fill in the IP addresses of your 

VoIP phones in the Setup. Click on the 
Recording tab and fill in the numbers 

separated by commas. This input field will 

only influence the display of call direction 

(incoming or outgoing). 
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3.4 V-Tap ISDN BRI and PRI 

See V-Tap Analog for information about the V-Tap in general. 

 

 
 

V-Tap ISDN BRI 
 

 

 

 

 

 

 

 
V-Tap ISDN PRI 
 

 

 

 

 

 
 

3.5 Call Recorder VoIP 

 

The Call Recorder VoIP is able to 

record telephone calls only if the 

V-Archive software is running. 

CR VoIP doesn’t have internal 

storage like the V-Taps. 

 

 

 

 

 
 

 

Note:   

Do you have a Call Recorder VoIP unit? You need to enter at least one 

‘VoIP channel’ license before the software can record your calls from this 

recorder; see Licensing. 
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3.6 V-Mic 

 
The V-Mic is, just as all V-Taps, a stand-alone device with an SD-card. It is 

able to record audio from a microphone while your PC is turned off. 

 

 
 

The web interface of the V-Mic is shown below for all the Tunnel settings, 

needed to upload to V-Archive: 

 

 
 

The External Storage is the IP address of the PC running V-Archive. 
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3.7 Call Recorder Pico 

 

 

The Call Recorder Pico can record from 
analogue and corded digital 

telephones, and from a microphone. 

This hardware is only able to record calls 

when the CR Pico software is running on 

your PC, and the Pico hardware is 

connected to the same PC. 

The Pico doesn’t have internal storage. 

 

You can import recordings from the CR Pico database to the V-Archive 

software. The import of recordings from the CR Pico works the same as 

from the Oygo. See Oygo for more information about this import. 

 

 

 

3.8 Oygo  

 

The Oygo is software for the PC to 

record soft phones and headsets. Oygo 

and V-Archive can share a database. 

This is the case when the Data 

Directory is the same in both 

applications. See the Data Storage tab 

of the Setup window of both 

applications. 

 

Do you already have the Oygo installed 

and are there recordings listed in the 

Oygo database? And do you want to 

transfer these recordings to the V-Archive database? Then import the 

Oygo database to the V-Archive software like described on the next 
page. 
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Open V-Archive and select Import from the Actions menu. Browse to the 

folder where the call archive of the Oygo is stored. Select ‘recinfo.mdb’ 

and click Open. 
 

 
 

The V-Archive opens ‘recinfo.mdb’ from the Oygo folder and merges it 

with its own ‘recinfo.mdb’. This will also copy the Oygo recordings to 

the V-Archive folder. 

 
Now we must change the folder that the Oygo will use in the future. 

From now on, this is the same folder V-Archive uses. To do this, in the 

Oygo software, select Setup from the Options menu and click on Data 

Storage. Fill in the Data Directory. The picture below shows the Oygo. 
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This should be the same directory as set in the V-Archive software. The 

picture below shows the V-Archive. 
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3.9 V-App 

 

V-App is a Vidicode App for Android 

mobile phones. V-App records and stores 
telephone calls including phone numbers, 

time, date and duration of the recording. 

It can also record memos. 

 

The V-App is able to store the recordings 

in the cloud. In the V-App you can specify 

the cloud storage provider, such as 

Dropbox or Google Drive. 

 

Download the recordings from the cloud 

to your PC. Configure V-Archive to import 

these files. Then you can play and archive 

them on your PC with the V-Archive 

software. 

 

See Import. 
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4 Options menu 

 

4.1 Language 

The V-Archive application supports several languages and it is possible to 
change the language at any moment; select your language in the Options 

menu and just click.  

 

 
 

The supported languages are Arabic, Danish, German, Spanish, French, 

Italian, Dutch, Polish, Portuguese, Swedish, US English, and UK English. 

4.2 Setup 

 
 

Administrator settings 
Some settings are only available as administrator. Click this button to 

restart the application as admin and open these settings. 
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4.2.1   Recording 
 

 
 

IP Addresses of phone 
Do you have a CR VoIP or V-Tap VoIP? Enter the IP address of the local 

VoIP phone. If multiple phones are used, input the IP address of each 

phone, separated by commas. This setting is used to determine what is 

the local and remote side of a call, which is needed to determine the 
direction of a call (inbound or outbound). 

Instead of specifying individual IP addresses, it is also possible to specify 

an IP range, using the standardized network prefix notation. Example: 

192.168.0.0/24 means that the first 24 bits are fixed, and the last 8 bits 

may vary, which means that, in this example, all IP addresses that start 

with 192.168.0.x would be considered local. 

 

Note1: Enter the IP address of the local VoIP PBX might cause, that the 

          shown direction of the call is incorrect. 

Note2: This IP address is not used as a filter. 

 

Minimum Duration 
This refers to the minimum duration of a recording for it to be stored. 

Standard setting would be 3 seconds. Recordings shorter than the set 

duration are not stored. 
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Telephone number filter (press Edit) 
Applicable to CR VoIP and V-Tap VoIP. 
Record everything: Calls are recorded regardless of any number. 

Only record calls that match the filter: Calls that do not involve any of        

the specified telephone numbers are not recorded. 

Only record calls that do not match the filter: Call that involve any of the 

specified telephone numbers are not recorded. 

 

Silence on Demand 

Record on Demand 

Store on Demand 
Manually select if you want to be able to insert silence on demand, start 

and stop recordings on demand or store the current ongoing call on 

demand. The related buttons to press can be found in the Actions tab. 

See further the Help function in the software. 

 

Advanced settings 
When pressed, an extra pop-up menu appear with more settings. 

For a description of those settings, see the built-in text in menu Help. 

 

Accept connections from V-Tap 
The Vidicode-Tap units are stand-alone recorders, housed in the same box 

as the CR-VoIP unit.  There are 5 types;  the  V-Tap VoIP,  V-Tap Analog,    

V-Tap ISDN BRI,  V-Tap ISDN PRI  and V-Mic (see also 3.2 till 3.4). 

All V-Tap units can store their data onto an SD card and can send the 

recordings over a network to a PC with V-Archive or an Apresa recorder. 

 

If you have a V-Tap or V-Mic, you don’t need to add ‘VoIP channel’ licenses 

in V-Archive. This type of license is inside the V-Tap or V-Mic unit. With a 
valid license, the unit will be able to upload recordings to a PC running 

the V-Archive software. 

For every recording channel used by the V-Tap VoIP, one “Recording 

License V-Tap VoIP for PC” is needed inside the V-Tap VoIP. Those licenses 

are sold separately. 

 

For more information, see www.vidicode.com 

 

 

http://www.vidicode.com/
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4.2.2   Licensing 
 

 
 

This page shows the status of previously entered licenses. 

 

 Click the Add button to enter a new license key. 

 

To be able to move the license from one PC to another, the license needs 
to be deactivated first on the original PC.  

 

 Click the Deactivate button to remove a license.  

 Use the original license code on the second PC to activate again. 

 

VoIP channels 
These are recording licenses for the Call Recorder VoIP unit or for a VoIP 

soft phone that operates on the same PC. 

The number of concurrent VoIP recordings is determined by the available 

VoIP channels, up to a maximum of 4. At least 1 license must be entered, 

otherwise no call recording is done from a CR VoIP unit or softphone! 

 
Note for V-Tap VoIP 

If you have a V-Tap VoIP recorder, you do not need to add VoIP channels. 

This type of license is inside the V-Tap.  
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Upload channels 
These licenses are needed when the recordings must be uploaded to a 

Call Recorder Apresa. 

 

Import V-App phones 
These licenses are needed when recordings must be imported from, for 

example, a Dropbox account. You can buy additional import V-App 

licenses. You receive one “Import V-App license” for free. See Import. 
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4.2.3   Playback 

 

 
 

Device 
The playback device that must be used for playback of recording, can be 
selected from the list. In most cases the sound card of the computer is 

used for playback. 

 

Channel 
The channel of the Playback device must also be selected. For the channel 

selection of the soundcard, usually the Wave or PC Speakers must be 
selected. 

 

Volume 
The default used playback volume level can be changed here. 
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4.2.4   Data storage 
 

 
 

Data Directory 
In this directory all call recordings are stored. Type the name of the 

directory, or press the Browse button to select a directory. This directory 

must already exist. The data directory must be accessible from the user 

account that runs the background service. The user that runs the 
background service can be changed in the Windows services screen. Drive 

mappings (X:) are generally not available, and UNC path notation should 

be used instead (\\server\share\dir\). The background service is named     

"V-Archive Recorder" or "Call Recorder VoIP". 

 

Directory structure 
Within the data directory, the recording files can be stored according to 

the year, month, day, and hour of when the recordings started. 

 

Automatic removal on program exit 
When this option is enabled, and the calls are as old as the entered 

number of days, or older, then the recorder files are deleted permanently 

from the archive. 

For example, if the number of days is set to 1, it means that all calls of 

yesterday and before are deleted automatically on program exit. 

 

file://///server/share/dir/
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Export recordings to Call Recorder Apresa 
This function uploads and adds the recordings to an Apresa Server. 

- HTTPS: The use of HTTPS is needed for secure communication 
- IP address or IP name: of the Call Recorder Apresa, to which the 

recordings must be uploaded 

- API authorization code: this password is needed to upload calls to the 

Apresa. It must match with the configuration of the Apresa. 

Click on the blue arrow button to restart uploading to Apresa from the 

start. This can be used when switching to another Apresa that does not 
contain any data yet, and has to receive all data from the start. When 

exporting to the same Apresa, this can (and in most cases will) lead to 

double recordings on Apresa. 

 

Export data to a directory 
This export feature provides a continuous backup of both the call meta 
data in the database, and the recordings (audio files). The export 

directory could point to a network location, but must be accessible by the 

background service (see explanation earlier for the data directory). The 

export filename of the database includes the date. This means one copy 

of the database is stored per day. Recordings that are deleted from the 

main archive are not deleted from the export location. New recordings 
(the audio files), if any, are exported once per minute. The database is 

copied every hour, and also after new recordings are exported, but not 

more often than once per 10 minutes. Export is done by the background 

service, even when the user interface program is not open. 

Click on the blue arrow button to restart exporting recordings from the 

start. This could be used after switching to a different data export 

directory that is yet empty, and has to receive all data from the start. 
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4.2.5   Import 
 

 
 

V-App is a mobile phone application that records phone calls on an 

Android smartphone. The App has an option to export recordings to a 

cloud storage, such as Dropbox. If you have this linked to a directory on 

your PC, you can let the software import the recordings from there. The 

software automatically detects when new files are put in the directory. If 
the recording is not in wave (.wav) format, it will be converted to this 

format in the background. 

 

Source directory:  The directory that contains the V-App recordings. Click 

Browse to select a directory. 
 

Local Phone ID:  The Local Phone ID must correspond to same setting in 

the V-App. Recordings with another ID are not imported. If this option is 

left empty, the first encountered Local Phone ID will be used 

automatically. If an additional ‘Import V-App’ license is installed, up to 4 

phones can be imported. 

 

Delete source file after import:  After import, the source will be deleted, 

if this setting is enabled. Recordings that were skipped during import, are 

not deleted. 
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4.2.6   Start / Exit 
 

 
 

Start-up with Windows 
Starts the application at logon in Windows. 

 

Start in System Tray 
Starts the application in the system tray (lower right area in Windows). 

 

Stay active in system tray, when main Window is closed 
When this option is on, the application will move to the system tray and 

continue to record calls, when the main window is closed. To completely 

close the software, right-click on the system tray icon and select Exit or 

select File and then Exit from the main menu. This only closes the visible 

application and does not apply to the VoIP recording engine, which runs 
in the background as a service continuously. 
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4.2.7   Security 
 

 
 

It is possible to protect the V-Archive application with a password. 

Deleting the recordings and the settings of the program can be protected 

separately.  

 

 Check the item you want to protect. 

 Enter the password. 
 Click ‘Apply’ to save the password. 

 

Upon deleting a recording or entering the settings the user will be 

prompted to enter the password.  

Once entered during a session, the password remains active for about 10 

minutes. If you want to reactivate the password immediately, you must 

restart the application. 
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Store recordings encrypted 
When enabled, new recordings will be stored encrypted. To playback an 

encrypted recordings, the password must be entered. When you export 

or email a recording, the recording will be decrypted, but the original 

recording remains encrypted. 

Use the Change password function to choose another password that 

must be entered to playback encrypted recordings. The new password 

applies to both old and new recordings. To change the password, first 

the current (old) password must be entered. Both the password and the 

key file are required to decrypt recordings. 

If the password or the key file is lost, recordings cannot be decrypted, 

and there is no recovery method. This key file is stored in the 

configuration directory, usually “C:\ProgramData\Vidicode\CRVoIP\play.key”. 
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4.2.8   Display 

 

 
 

All recordings made with the Call Recorder VoIP unit, the V-Tap units and 

the V-App application are stored in a database. The setting Visible 

Columns allows you to select which columns are displayed. 

 

Auto size columns can be checked if you want the columns in the list view 

to adjust to the screen size automatically.  

 
Activate the Actions tab can be checked to automatically switch over to 

the actions tab when a call becomes busy. This is useful when recordings 

must be started or stored manually (on demand). 

 

 

 

 

 

NOTE:   

Always click Apply after changing one or more settings. 
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5  Playback control 

 

Select a recording and click the Play button to start playback, or double-

click on a recording, or right-click on it and select Play. 

 

 
      A    B    C  D                           E                                    F               _               
 

A:  Moves the playback position backward. Keep the button pressed 

to increase the speed. 

B:  Start or Pause the playback of the currently selected recording. 
C:  Stop the playback or recording. 

D:  Moves the playback position forward. Keep the button pressed to 

increase the speed. 

E:  Information about the current playback or recording is displayed 

here. Click on the progress bar to move to a specific position in 

the playback. 

F:  Controls the playback volume.  

 

 

5.1  Hotkeys 

 

The following key combinations are available to control playback with a 

keyboard: 

 

Key             Function 

Ctrl + P or Spacebar Play / Pause 

Ctrl + L Stop 

Ctrl + U Backward 
Ctrl + I Forward 
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6 Layout and Menus 

 

When the software is started the program looks like this: 

 

 
 

These are the items on the main screen: 

 

 The main Menu bar (pull-down menus at the top) 

 The Playback control bar 

 The view-select buttons on the left  

 The tab-select buttons (List, Search and Actions)  

 The list of recordings (the large remaining area) 
 

 

6.1 Main menu 

 

The main Menu gives access to the sub-menus File, View, List, Actions, 

Options and Help.  In the following paragraphs these menus are 

explained.  
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6.1.1 File menu 
 

The File menu has five options. New, Open, Import (2x) and Exit. 

 

 
 
‘New’ will start a new call archive. This means that a new database is 

created in which newly made recordings will be stored.  A dialogue opens 

in which you are asked to specify the location of the new database folder.  

The new Archive can be located on your PC or on the network.  

 

‘Open’ allows you to open an existing archive (database). This can be an 

archive on the PC or on the network.  

 

Both ‘Import V-Tap…’ options can be used to retrieve recordings from any 

Vidicode-Tap unit.    That can be a V-Tap VoIP, a V-Tap Analog or a V-Tap 

ISDN BRI or PRI. All V-Tap units store their data onto an SD-card. 

 

‘Exit’ closes the application.  

 

6.1.2 View menu 
 

The View menu has four options: ‘Display the List Tab’, ‘Display the Search 

Tab’, ‘Display the Audio Tab’ and ‘Move to system tray’. 

 

 
 

The ‘Display…’ options open the corresponding Tab to the left of the List 

view in the main screen.  

 

‘Move to system tray’ puts the active application in the system tray. The 
system tray on a PC is positioned at the lower right corner of the screen. 

 



V-Archive Manual EN v1.4   © 2017-2020 Vidicode 31 

 
To retrieve the application from the system tray, just click on the icon. 

 

 

6.1.3 List menu 
 
Recordings are saved to a database. In the software this database is 

referred to as Archive and is shown as a list in the main screen.  

  

 
 

The List menu has the same options as the List tab buttons on the left side 

of the window. You can select from what predefined timeframe you want 

to see the recordings in the List view area. This can be: 

‘All’, ‘Today’, ‘This week’, ‘This month’, ‘This year’ and ‘View Recycle Bin’ 

 

The actual list of recordings on the right changes with the selection you 

make. To view a list of the complete database, click the All-button in the 

List tab. 
 

Clicking the Column headers will sort the list by that column, i.e. if you 

want to see all outbound calls, click the column header ‘Direction’. The 

calls will be grouped by direction ‘in’ or ‘out’.  
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6.1.4 Recycle Bin 
 

The Recycle Bin resembles Windows Recycle Bin. To put in the bin: 

 

 Select one or more recordings in the archive 
 Delete recording(s) with the Delete key on your keyboard, 

or  

 Right click and select ‘Delete’.  

 

In both cases a dialogue opens asking you to confirm the deleting.  

 
 Use the SHIFT + Delete keys to permanently delete a recording 

without moving it to the recycle bin first.  

 

The deleted recordings end up in the Recycle Bin. They are still in an 

archive. To Permanently delete the recordings: 

 

 Press ‘View Recycle Bin’  

 Select the recordings you want to delete permanently  

 Right click and select ‘Delete’. 

 

A dialogue opens asking you to confirm the deleting 
 

To permanently delete all recordings in the Recycle Bin: 

 

 Open the Actions menu 

 Go to Recycle Bin 

 Select ‘Empty’. 
 

Recordings can be restored to the database: 

 

 Click ‘View Recycle Bin’ in the List view 

 Select one or more recordings you want to restore 

 Right click and select ‘Restore’, 

or 

 Open the Actions menu  

 Go to Recycle Bin 

 Select one or more recordings and select ‘Restore’, 

or 

 Open the Actions menu or click ‘View Recycle Bin’ in the List menu 

 Go to Recycle Bin 

 Select one or more recordings you want to restore 

 Right click and select ‘Restore’. 
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6.1.5 Actions menu 
 

In the Actions tab, you can Backup the recordings to CD, Import an 

previously made back up, Export recordings as audio, E-mail recordings, 
view Sub archives, make a network trace and more. 

 

 
 

To CD 
This function is used to back up or export an entire database or a selection 

of recordings on CD.  
 

Note that you need to use a separate CD-writing application for writing 

the files to CD. 

 

If you do not want to burn the entire database onto CD: 

 
 Use the Search Tab to select the recordings you want to back up 

 Then go to the Actions menu and  

 Select To CD.  

 

The following dialog opens (see next page): 
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If you want to copy the entire database on CD the options ‘Selection’ and 

‘Active Query’ are greyed out.  

If you have selected the database, the radio button ‘Selection’ will be 

active.  

 Browse to the location where you want to store the Export 
directory, using the ‘Browse…’ button, this can either be 

on the PC or on the network.  

 Adjust the maximum size if needed.  

 Click OK 

If you back up more data than the ‘maximum’ size, multiple directories 

will be created as needed for multiple CD’s.  
 

Import  

Will also open a dialogue in which you can select the directory from which 

you want to import a back up.  

 Select the database and click OK to import it.  

 

Export  
Individual recordings and groups of recordings can be exported from the 

application. Select in the menu Actions, Export. 

 

The following dialog opens (see next page): 
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Select if you want to export the current selection or the whole query. 

The Export directory is the location where the files will be stored. This 

location can be changed to your convenience. 

 

The following recording properties can be preserved in the filename of 
the recordings: 

 

o %I is the number of the recording 

o %D is the date of the recording 

o %T is the time of the recording 

o %X is the duration of the recording 
o %N is the name associated with the recording 

o %P is the telephone number of the recording 

o %> is the direction of the call 

o %C are the notes related to the recording 

 

E-mail 
It is possible to send a single or a selection of recordings using e-mail.  

 

 First select the recording you want to send by e-mail.  

 

There are two ways to start an e-mail: 

 

 Open the Actions menu and select ‘e-mail’. An e-mail dialogue 

opens to which the recording is attached.  The recording data is 

displayed in the e-mail. Enter the receivers name and send.  

 The second possibility is to select a recording, then right click and 

select ‘e-mail’.  
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Sub Archives 
It is possible to combine separate archives into one new archive. The new 

archive will be the ‘Current. 

 

For example, a Supervisor may have access to a set of archives. These 

archives should be on an accessible location for the supervisor like a 

network drive. The combined archive is created by copying new 

recordings from the ‘Sub Archives’ to the ‘Current Archive’. 

 

To define which Sub Archives you want to access, 

 

 Select Add and browse to the location of the Sub   Archive. 

 Select whether you want to copy the recordings manually,  

(click “Copy new recordings from Sub Archive” or automatically 

(check “Auto Copy”). 

 

To delete a Sub Archive, 

 

 Select Delete. 

 

New recordings will no longer be copied from the deleted Sub Archive. 

Previously copied recordings stay in the Current Archive. 

 

 

Restart recording component 
The background task that captures all the recordings on the PC 

(OrkAudio.exe) can be restarted manually with this option. 

Warning: Ongoing recordings are lost when doing this! 

 
 

Network trace 
This option is mainly used for debug purposes. A trace of the network 
traffic can be started and stopped here. 

The saved file can then be sent to support@vidicode.com, along with a 

description of the problem. 

Be sure there was a complete phone call during the time that the trace 

was active. 

 
 

 

mailto:support@vidicode.com
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6.2 Names and Notes 

 

You can assign a name and telephone number to each recorded call. 

Select the call in the main window, double click on the Notes of the 
recording, or right-click and select Edit. The following dialog opens: 

 

 
 

To change the name that is attached to the telephone number, edit the 

name. To attach notes to the recording, fill in the Notes field.  

The telephone number cannot be edited. 
 

Click OK to save the name and notes. 
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6.3 List, Search and Actions buttons 

6.3.1 The List button 
 

 
 

The List button displays the List view. To the left are the buttons with 

which a selection for the view can be made. To the right, the main screen, 

displays the (selection from) current archive.  

 

6.3.2 The Search button 
 

 
 

In the Search tab, you can define a Search. A Query based on a recording's 

date, week, time of day, duration, device, telephone number, name or 

notes. 

 

 Click on the + in front of the properties you want to use 

in your query (one or more) and fill in the range or name, 

then click Search.  
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Save a query 

It is possible to save a custom query for regular execution. After clicking 

on the Search button, the Add Query button will appear. You can specify 

a name for the query. 

 

 
 

The query will be saved with the entered name and a shortcut to the 

saved query will be added to the List tab. To run the query, select on the 

button in the List tab. Naturally, new recordings that satisfy the query will 

be included when the query is executed. 
 

 

6.3.3 The Actions button 
 

 
 

In the Actions tab you find the buttons to manually control recording. 
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7 Software Updates  

 

The V-Archive software can check for a software update on the internet. 

 

 Select Help in the menu  

 Select Check for Update 

 In the pop-up windows click Check for Update 

 

 
 

In the case of an available update, a short list of fixes of the last version 

is displayed. To update: 

 
 Press Download to start downloading the update.  

 After downloading the new version will be installed automatically. 

 

 

 

Note:  

The software update only works when the PC has access to the internet. 
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8 Acknowledgements 

 

8.1  Privacy 

 
When recording telephone conversations, the privacy of your 

conversation partner must be considered.  

 

In some countries there is an obligation to notify your conversation 

partner of the recording. Check your national legal obligations on this 

and other issues concerning the use of any Call Recorder. 

 

Vidicode is not a source of official interpretation of laws of any country 

or state and shall not be construed as a source for making decisions 

whether to provide notification or not. Vidicode assumes no liability 

regarding incorrect notification of call recording. 

 
 

8.2  Liability 

 

Correct functioning of the call recording solutions cannot be guaranteed 

under all conditions and thus we do not accept any liability for loss of 

information or other damages due to the use of V-Archive and the call 
recorders. 
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